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Introduction 
Microsoft Excel 2007: Functions and Data Analyses is designed to be an advanced course for 
students who use Excel extensively. In this two-part course, the basic structure and the use of 
various functions will be discussed. Explore the definition of Excel functions by learning various 
Date and Time functions, as well as advanced logical functions. Additionally, attendees will be 
taught how to use data validation, ending with applying the knowledge to create a checkbook 
register used in real life. 

Add-ins 
Add-ins are supplemental programs that add custom commands, features, and functions to 
Microsoft Office. Many features and functions require certain add-ins to be loaded for operation. 
The add-in programs listed in Table 1 - Default Add-ins are installed or can be located in the 
Microsoft Office installation CD.  

Table 1 - Default Add-ins 

Add-in Description
Analysis ToolPak Adds financial, statistical, and engineering 

analysis tools and functions 
Analysis ToolPak VBA Allows developers to publish financial, statistical, 

and engineering analysis tools and functions using 
Analysis ToolPak syntax 

Conditional Sum Wizard Creates a formula that sums data in a range if the 
data matches the criteria specified 

Euro Currency Tools Formats values as Euros, and provides the 
EUROCONVERT worksheet function to convert currencies 

Internet Assistant VBA Allows developers to publish Excel data to the Web 
by using Internet Assistant syntax 

Lookup Wizard Creates a formula to look up data in a range by 
using another known value in the range 

Solver Add-in Calculates solutions to what-if scenarios based on 
adjustable cells and constraint cells 

To ensure that the functions covered in the handout work properly, three add-ins must be loaded: 
Analysis ToolPak, Lookup Wizard, and Solver Add-in. 

To load add-in programs: 
1. Click the Office Button and click the Excel Options button. The Excel Options dialog 

box opens. 
2. Click the Add-Ins category on the left. The list of active and inactive add-ins is displayed. 
3. On the Manage: list box, select Excel Add-ins. Click on the Go… button. 
4. In the Add-Ins available: list box (see Figure 1), select the check box next to the add-in 

to be loaded, ►OK button.  
5. If the add-in selected is not installed on the computer, a Setup program will start and may 

prompt for the Microsoft Office CD.  
6. Follow the instructions given by the setup program and finish the installation. 



 

 
Figure 1 - Add-ins Available List Box 

To unload add-in programs: 
1. Click the Office Button and click the Excel Options button. The Excel Options dialog 

box opens. 
2. Click the Add-Ins category on the left. On the Manage: list box, select Excel Add-ins. 

Click the Go… button. The Add-ins dialog box opens. 
3. In the Add-Ins available: list box, clear the check box(es) next to the add-in(s) to unload, 

►OK button. 

Date & Time Functions 
Excel turns most data into some numeric form, and time is no exception. Excel stores dates as 
the number of days past since 01/00/1900 and time is just a number representing a fraction of a 
day. For example: the date and time 01/01/2000 12:00 PM is stored as the number 36526.5, since 
36526 days and 0.5 day (12 hrs) have passed since 01/00/1900.  

Beginners often find that working with dates and times in Excel can be frustrating. This section 
presents some useful day and time tools, and demonstrates that time calculation is no more than 
basic addition and subtraction. 

TODAY AND NOW FUNCTIONS 
These two functions are time stamp tools. TODAY() returns the serial number of the current 
date. NOW() returns the serial number of the current date and time. Both are examples of 
functions that do not require any arguments, and no content is typed within the parentheses of the 
functions. 

To use these date and time functions: 
1. Open “Date & Time Funtions.xlsx”. 
2. Type the formula [=today()] into cell A2 to show the current date (see Figure 2).  
3. Type the formula [=now()] into cell D2 to show the current date and time (see Figure 3). 
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Figure 2 - Result of TODAY Function 
 

 

Figure 3 - Result of NOW Function 

EXTRACTING TIME INFORMATION USING FUNCTIONS 
Excel has functions that extract specific information from a time stamp (see Table 2 - Time 
Functions). For example, the YEAR function is used to obtain a number corresponding to the 
year of a date.  

For the following examples, cell D2 has the following date, “11/29/2007 17:53:01”. Type the 
following functions into different cells and compare the results. 

Table 2 - Time Functions 

Function Description Result 

=YEAR(D2) Returns year as a number 2007 

=MONTH(D2) Returns month as a number 11 

=WEEKNUM(D2) Returns week as a number 48 

=DAY(D2) Returns day as a number 29 

=HOUR(D2) Returns hour as a number 18 

=MINUTE(D2) Returns minute as a number 1 

=SECOND(D2) Returns second as a number 7 

CALCULATING DATE DIFFERENCES 
By using the above list of functions, it is easy to calculate the difference between two dates. The 
year difference between two dates is the result of subtracting the year value of the first date and 
year value of the second date. 

To calculate a year difference between dates: 
1. Type the formula [=YEAR(A13)-YEAR(D13)] into cell C15.  
2. If necessary, format cell C15 to display the result as a number. 

a. Make sure cell C15 is selected. On the Home tab, click on the Format button 
under the Cells group. Select Format Cells from the list. 

b. Click on the Number tab if necessary. 
c. Select General in the Category: list box.  

The month difference between dates is the result of subtracting the month value of the first date 
and the month value of the second date plus the difference in years. 

To calculate the month difference between dates: 
1. Type the formula [=MONTH(A13)-MONTH(D13)+(C15*12)] into cell C16.  
2. If necessary, format cell C16 to display the result as a number. 

a. Click on the Home tab. Under the Cells group, click on the Format button. Select 
Format Cells… from the list. 

b. Click on the Number tab if necessary. 
c. Select General in the Category: list box.  
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The number of days between two dates is the result of subtracting the first date and the second 
date.  

To calculate the day difference between dates: 
1. Type the formula [=A13 - D13] into cell C17.  
2. If necessary, format cell C17 to display the result as a number. 

a. Make sure cell C17 is selected. On the Home tab, click on the Format button 
under the Cells group. Select Format Cells from the list. 

b. Click on the Number tab if necessary. 
c. Select General in the Category: list.  

Advanced Logical Formulas 
IF functions are good tools for decision making in a worksheet. Nesting multiple levels of IF 
functions, or adding AND, OR, or NOT functions can increase their complexity. Besides the 
aforementioned, many other functions can be used in combination with the IF function in a 
single formula to create advanced logical formulas. 

IS FUNCTIONS 
Within the category of Information functions, there are some functions that all start with “IS”, 
called IS functions. IS functions check a cell and return TRUE or FALSE depending on the value 
in that cell. Table 3 below shows a short list of the most commonly used IS functions. 

Table 3 - IS Functions 
Function Name Description
ISBLANK Returns TRUE if the value is blank 
ISNUMBER Returns TRUE if the value is a number 
ISTEXT Returns TRUE if the value is text 
ISEVEN Returns TRUE if the number is even 
ISODD Returns TRUE if the number is odd 
ISERROR Returns TRUE if the value is an error 

To test the IS function with an odd number: 
1. Open “Logical Functions.xlsx”.  
2. Type an odd number in cell D2 (see Figure 4).  
3. Type in the following list of formulas. Note that the results of the functions are either 

“TRUE” or “FALSE”. 
a. [=ISBLANK(D2)] in cell B4.  
b. [=ISNUMBER(D2)] in cell B6.  
c. [=ISTEXT(D2)] in cell B7. 
d. [=ISEVEN(D2)] in cell E6. 
e. [=ISODD(D2)] in cell E7. 

 

 

Figure 4 - IS Function with an ODD Number 

 

Figure 5 - IS Function with an EVEN Number
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4. Type an even number in cell D2. The results of the functions change automatically (see 
Figure 5).  

5. Test with a text string by typing [test] in cell D2. Note that the result of the functions 
ISEVEN and ISODD changes to #VALUE because the functions ISEVEN and ISODD 
only accept numbers in their arguments. Any other type of value will return this error. 

 
AVOIDING ERROR MESSAGES 
Excel worksheets often contain functions that take in arguments from user inputs or from results 
of other functions. Sometimes, these functions return error messages instead of valid results. This 
occurs because of invalid argument types, invalid reference to cells, or wrong number of 
arguments.  

One way to prevent the display of these error messages is by using the functions IF and 
ISERROR to find and filter those errors. By using the ISERROR function nested in the IF 
function, a formula can be set to only display the result when it is correct and hide any error 
values that may occur.  

The function ISERROR(value) takes in a single value to be tested. If value is an error value 
(#N/A, #VALUE!, #REF!, #DIV/0!, #NUM!, #NAME? or #NULL), then the function will return 
TRUE. Otherwise, it will return FALSE. The result of this function is usually used as the 
condition of an IF function to perform the filtering. 

To filter the errors caused by an invalid argument type: 
1. Type in the formula [=IF(ISERROR(E6),  "ERROR!!!", "Contains no error")] in cell 

F6. This formula will evaluate the cell E6, which contains the function “ISEVEN(D2)” 
(see Figure 6). If the cell does not contain any error message, then the IF function returns 
the text “Contains no error”. Otherwise, it returns the text “ERROR!!!”.  

2. Type formula [=IF(ISERROR(E7),  "ERROR!!!", "Contains no error")] in cell F7 to 
filter the error message in E7. 

 

Figure 6 - Message with a Valid Argument Type 

COUNTIF 
The COUNTIF function counts the number of cells within a range that meet the given criteria. It 
has the following syntax: 

=COUNTIF (range, criteria) 
range:  The range of cells to count cells from. 
criteria:  A comparison criteria which must be in the form of a number, expression, or text. 

See Table 4 below for different types of criterion.  
 

Table 4 - COUNTIF Criteria Types 

Type Example  DESCRIPTION

Number  
=COUNTIF(range, 25) Counts all cells containing a 

numeric value 25 
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Type Example  DESCRIPTION

Text 
=COUNTIF(range, “TEXT”) Counts all cells containing a 

textual value “TEXT” 
Cell 
Reference 

=COUNTIF(range, B2) Counts all cells containing the 
same value as cell B2 

Expression 
=COUNTIF(range, “>200”) Counts all cells having a value 

>200 

Function 
=COUNTIF(range, SQRT(100)) Counts all cells containing a 

value of 10 (SQRT(100))is 10 

A table of numbers is given in the current sheet ranging from cells A10 to C15. To count the 
number of occurrences of the number “34” in the given table: 

1. Type the formula [=COUNTIF(A10:C15, 34)] in cell E11 (see Figure 7). 

 
Figure 7 - Result of COUNTIF Function 

SUMIF 
The SUMIF function adds the cells within a range that meet the given criteria. It has the 
following syntax: 

=SUMIF (range, criteria, [sum_range]) 
range:  The range of cells to evaluate the criteria. 
criteria:  The condition or criteria in the form of a number, expression, or text that defines 

which cells will be added. It uses the same criteria type as the COUNTIF 
function. 

[sum_range]: The actual cells to sum if the corresponding number in the range meets the 
criteria. This parameter is optional and if it is not specified, the SUMIF function 
will apply the criteria and add the cells given in the range argument. 

  
NOTE: range and sum_range MUST be of same size and shape. However, they can be located 
in different parts of a worksheet, as well as in different worksheets. 

To add all numbers in the given table that is larger than 200: 
1. Type the formula [=SUMIF(A10:C15, “>200”)] in cell E13 (see Figure 8). 

 
Figure 8 - Result of SUMIF Function 



REFERENCE TO CELLS NOT IN CURRENT WORKSHEET 
Reference to cells in worksheets other than the currently active one or even to a worksheet in 
another Excel file is possible. It can be accomplished by specifying the file name, the worksheet 
name, and the cell reference in the worksheet. Table 5 shows the correct way to refer to a cell in 
a different location. 

Table 5 - Remote Location Cell References 

Location Reference
Other worksheet in the same workbook =Lookup!A2 
Other workbook with one word file name =[PivotTable.xls]Data1!A1 
Other workbook with spaces in file name ='[RiskAnalysis with formulas.xls]ABC'!A13 

NAMING CELLS AND RANGES 
A better way to refer to a cell or a range of cells is by using a descriptive name. Instead of 
referring to a cell by using the aforementioned ways, a descriptive name can be applied to 
represent a specific cell or range of cells. A defined name in a formula can make it easier to 
understand the purpose of the formula. For example, the purpose of the formula: 
=SUM(FirstQuarterSales) might be easier to identify than =SUM(C20:C30).  

Names are an absolute reference to cells and they are available to any sheet within a workbook. 
For example, the name ProjectedSales refers to the range A20:A30 on the first worksheet in a 
workbook. When ProjectedSales is used in any other sheet in the same workbook, it will refer to 
the range A20:A30 from the first worksheet. 

To create a name to represent a formula or a 
constant: 

 

1. Select the cell range A10:C15. 
2. On the Formulas tab, click on 

Define Name button under the 
Define Names group. 

3. In the Name: box, enter 
“First_Quarter_Sales” (see Figure 
9). 

 

Figure 9 - Define Name Dialog Box

 

NOTE: If a range of cells is not already selected, type [=], followed by the cell reference or 
constant value in the Refers to: box.  

To change or delete a defined name: 
1. On the Formulas tab, click on the Name Manager button under the Define Names group. 
2. Select the range you want to edit. Click on the Edit… button. 
3. Do one of the following:  

a. Change the name.  
i. Type the new name for the reference inside the Name: text box, and click 

the OK button.  
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b. Change the cell, formula, or constant represented by a name.  
i. Change it in the Refers to: text box. After changing, click the OK button. 

4. Select a range to delete and click on the Delete button. 
5. Click on Close to close the Name Manager dialog box. 

NOTE: 
• The first character of a name must be a letter or an underscore character. The remaining 
characters in the name can be letters, numbers, periods, and underscore characters. 
• Names cannot be the same as a cell reference, such as Z$100 or R1C1. 
• Spaces are not allowed. Underscore characters and periods may be used as word 
separators (e.g., Sales_Tax or First.Quarter). 
• A name can contain up to 255 characters. 
• Names can contain uppercase and lowercase letters. Microsoft Excel does not distinguish 
between uppercase and lowercase characters in names. For example, if you have created the 
name Sales and then create another name called SALES in the same workbook, the second 
name will replace the first one. 

Data Validation by Using a List 
Many times, when data is entered into a worksheet, there are some errors in the input that can go 
unnoticed. These input errors can cause major problems in the calculation of an entire worksheet. 
Fortunately, Excel has addressed this problem by providing data validation features that can 
validate data at the moment of input. One way to validate data entry is to limit the values to be 
entered by using a list of predefined values, which will automatically reject any input not on the 
list. 

CREATING A VALIDATION LIST BY USING DATA IN THE SAME WORKSHEET 
The list of data values can be located in the same worksheet or in a different worksheet. The 
instructions below will demonstrate how to create a validation list with data located in the same 
worksheet. 

To create a validation list with the data located in the same worksheet: 
1. Open “Validation.xlsx”.  
2. Select cell E5.  
3. Click on the Data tab, click on the upper part of Data Validation button under the Data 

Tools group. The Data Validation dialog box opens. 
4. Select the Settings tab to set the type of validation to be used for the cell. 

a. Click on the Allow: list box and select List. 
b. Click in the Source: textbox. Type in range [=$A$2:$A$10] if necessary, to set 

the values on the list.  
c. If available, check Apply these changes to all other cells with the same settings 

checkbox. This will apply the input messages and error messages displayed in this 
dialog box to other cells having the same data validation settings (see Figure 10). 

5. Select the Input Message Tab to type the message to be display when this cell is selected 
(see Figure 11). 

a. Type [SELECT YOUR NAME] in the Title: textbox.  
b. In the Input message: textbox, type the following message: [Click on the drop 

down arrow to select a name]. 



 
Figure 10 - Creating a Data Validation List Dialog 

Box 

 
Figure 11 - Creating an Input Message Dialog Box 

6. Click the OK button. Cell E5 will display a drop-down arrow  to the right of the cell 
whenever it is selected. 

7. Click cell E5 and use the drop-down arrow     to change the name selected. Observe 
that the lookup values change accordingly (see Figure 12). 

 
Figure 12 - Using Validation List with Formulas 

CREATING A VALIDATION LIST BY USING DATA IN A DIFFERENT WORKSHEET 
The basic concept is the same as before. However, the process of creating a validation list with 
data located in a different worksheet is a little bit more complicated.  

When typing in the source for the values in the list, only cell references in the same worksheet 
can be input into the Source: textbox. Ranges located in other worksheets can be referred to only 
by using named cell references.  

To create a name for a cell range: 
1. Select the “Lookup DATA” 

worksheet.  
2. Highlight the cell range A1:A9.  
3. Type [Names] in the Name Box. 

Now, the cell range 'lookup 
DATA'!A1:A19 has been assigned 
with this name and it can be 
referenced from anywhere in the 
workbook by using this name (see 
Figure 13).  

 
Figure 13 - Naming Cells Range 
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To create a validation list using data in a different worksheet:  

1. Select the “Validation” worksheet.  
2. Select the cell E5.  
3. Click on Data tab, click on the upper part of Data Validation button under the Data 

Tools group. The Data Validation dialog box opens. 
4. Select the Settings tab to set the type of validation to be used for the selected cell (see 

Figure 14). 
a. Click on the Allow: drop-down list and select List. 
b. Click in the Source: textbox. Type [=Names] to set the range of values to be 

included in the list.  
5. Click the OK button to close the dialog box.  
6. Click cell E5 and use the drop-down arrow     to change the name selected. Observe 

that the lookup values change accordingly. 

 
Figure 14 - Data Validation Using Range Name 

Creating a Check Register 
Formulas and functions in Excel enable the spreadsheet to update automatically whenever data is 
changed within a sheet. This makes it perfect for accounting purposes, like keeping a checkbook 
or balance sheet. This check register example combines all the features introduced in part 1. 

CREATING A VALIDATION LIST FOR EXPENSES CATEGORIES 
For the many categories of expenses, the easiest way to input data is by creating a validation list. 
By categorizing the expenses, it makes creating a summary of expenses a much easier task. 
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To create a validation list:  
1. From “Checkbook.xls” select the 

Lookup DATA worksheet.  
2. Create a name for the range of cells 

that contain all the expense 
categories. 

a. Select the range C1:C8. This range 
has a list with some expense 
categories: CAR, UTILITIES, 
GROCERY, LEISURE, DEPOSIT, 
OTHER, etc. 

b. Type a name for the range of 
cells into the Name Box. 
E.g., [categories] (see Figure 
15). 

 
Figure 15 - Renaming Expenses Range   

          

3. Create a list with all the categories to select from in the categories column of the 
checkbook. 

a. Switch to the “checkbook” worksheet by clicking the tab, and select cell C8. 
b. Click on Data tab, click on the upper part of Data Validation button under the 

Data Tools group. The Data Validation dialog box opens. 
c. From the Data Validation dialog box, select the Settings tab if necessary.  

i. Click on the Allow: drop-down arrow and select List. 
ii. Click in the Source: textbox. Type the name of the range [=categories] to 

apply the category values to the list (see Figure 16). 
iii. Click the OK button. Cell C8 will display a drop-down arrow      to the 

right whenever the cell is selected.  
4. Fill the range C9:C25 by copying C8 to apply the validation list to them as well.  

 
NOTE: In case these rows are not enough, simply extend the range to include as many 
rows as needed. Remember, the same range must be applied to all steps that follow. 

 
Figure 16 - Data Validation Dialog Box 
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CALCULATING BALANCE USING A FORMULA 
By using a formula, the balance can be calculated very easily, and updating the amount of one 
check can be immediately reflected in the current balance.  

To calculate the balance with a formula: 
1. Type the formula [=G7+F8-E8] in cell G8. This will calculate the balance by adding the 

previous row’s balance (G7) to the current row’s credit (F8) and subtracting any debit 
(E8) in the current row.  

2. Fill the range G8:G25 by copying G7 down to display the current balance in these cells. 

USING THE IF FUNCTION TO FILTER DISPLAY 
Since no new transactions have been recorded yet, all the cells in range G8 to G25 show the 
same balance as in cell G7. Since these cells do not display much useful information, it would be 
better to display the balance only if there is a transaction, and leave the cell blank if no new 
transactions have been recorded. This can be accomplished by using the “IF” function to filter 
the display. 

To create a display filter: 
1. Copy cells G6 and G7 into H6 and H7, respectively.  
2. Type the formula [=IF(AND(ISBLANK(E8),ISBLANK(F8)),"",G8)] in cell H8. This 

formula checks whether cells E8 and F8 are both empty. If they are not empty, meaning 
there is a new transaction, then the “IF” function will display the adjusted balance 
calculated in G8. Otherwise, it will just return a blank. 

3. Fill the range H9:H25 by copying H8 to obtain a second column with the balance. 
4. Now, hide column “G” from the view so that only one balance column is shown 

a. Right click on the column header “G” to display context menu. 
b. Select Hide to hide the column (see Figure 17). 

 

Figure 17 - Hiding a Column 

DATA ENTRY 
Now that the basic features of the checkbook have been created, type in some data to test the 
behavior of the validation list and the formulas. Table 6 demonstrates a sample list of expenses. 

To record a deposit for $2000 on the date 01/05/2008: 
1. Type [01/05/2008] into cell B8. This is the date of the transaction.  
2. Select the cell C8 to display the     drop-down arrow next to the cell. Click the arrow 

and select DEPOSIT from the list. If needed, use cell D8 to type a description.  
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3. Since this is a deposit, the $2000 amount should go into the credit column. Type [2000] 
into cell F8. Notice that the balance changes accordingly. 

To record check #122 for $45.57 paid to Albertson’s for grocery on the date 01/07/08: 
1. In cell A9, type [122] as the check number. 
2. Type [01/07/2008] into cell B9. This is the date of the transaction.  
3. Select cell C9, and use the    drop-down arrow to select GROCERY from the list. In 

cell D9, type [Albertsons] for the description. 
4. This is an expense, so it will be recorded in the debit column. Type [45.57] into cell E9. 
5. Practice by entering the following table of expenses into the checkbook register and 

compare the results (see Figure 18). 

Table 6 - Sample List of Expenses 

Check # Date Expense Detail Amount 

123 01/12/08 Payment for apartment rent 600.00

124 01/15/08 Buy grocery at VONS 60.00
125 01/15/08 Books for Winter Quarter 285.00

126 01/20/08 Pay Phone Bills 30.00

127 01/21/08 Car payment 350.00

 
Figure 18 - Data Entry Result 

CREATING A SIMPLE SUMMARY 
A simple summary can be created to clearly show the current balance and a summary regarding 
each category of expenses.  

To display the current balance: 
1. Type [=G25] in cell A4. 
 

NOTE: Recall in “Calculating balance using formula” (step-by-step on page 13), formulas 
were used in column “G” to calculate the balance. So the last row of column “G” has the current 
balance value. Even though column “G” is hidden, it still contains the values calculated by the 
formulas, and all the cells in the column can still be referred from other formulas.  
NOTE: The value G25 might be different depending on the number of rows created previously. 
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To create a summary of the number of checks used for “HOME” transactions: 
1. Create a validation list with the expense categories in cell C4. This drop-down list will be 

used to choose the category for the summary to be displayed. 
a. Select cell C4 and create a validation list by using the same categories list used 

for the checkbook’s category column (refer to the “Creating a Validation List for 
Expenses Categories” section if necessary). 

2. Display the number of transactions in cell D4 for the category chosen in cell C4. 
COUNTIF is the perfect function to be used in this case.  

a. Type the formula [=COUNTIF(C8:C25,C4)] in cell D4. This will count the 
number of occurrences of the category selected in cell C4 in all the expenses. 

3. Calculate sum of debits and credits for the category selected in cell C4. SUMIF function 
is used to accomplish this. 

a. For the sum of debits, type the formula [=SUMIF(C8:C25,C4,E8:E25)] in cell 
E4. This will look for the category selected in cell C4 in the checkbook’s category 
column and add the values in the debit column that has same category. 

b. For the sum of credits, type the formula [=SUMIF(C8:C25,C4,F8:F25)] in cell 
F4. This will look for the category selected in cell C4 in the checkbook’s category 
column and add the values in the credit column. 

4. Click cell C4 and use    to select HOME from the list. Notice that the # of transactions, 
Debit total and Credit total automatically update their values accordingly (see Figure 19). 

 
Figure 19 - Summary of Checkbook Register 

USING CONDITIONAL FORMATTING 
From the above example, both instances of “HOME” expenses were easily found. But as the list 
grows, it may be difficult to look for certain categories of transactions. Conditional formatting 
can be applied to the cells under the checkbook’s category column so that the format of the cells 
will change if they meet a given condition. In this case, the conditional formatting will change 
the cell color and font settings of the cells that contain the category specified under “summary”. 

To apply conditional formatting: 
1. First, select all the cells to which conditional formatting should be applied (in this case 

the range C8:C25). 
2. Click on the Home tab, select Conditional Formatting command under the Styles group. 
3. From the Conditional Formatting list, point to Highlight Cells Rules and click Equal to.  

In the Format cells that are EQUAL to: text box, type [=$C$4] (see Figure 20). 
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Figure 20 - Conditional Formatting Dialog Box 

4. Click on the drop-down arrow of the with list box. Select Custom Format… 
5. Apply a bold effect, found under the Font tab (see Figure 21). 
6. Choose a background color to be applied under the Fill tab. 
7. Click the OK button to close the dialog box. 

 
Figure 21 - Format Cells Dialog Box 

 
8. Click the OK button to close the 

Conditional Formatting dialog box 
and apply the changes. Notice that 
all expenses categorized as “HOME” 
are bolded and highlighted (see 
Figure 22). 

 
Figure 22 - After Applying Conditional Formatting 
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